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Chapter 1 - Introduction to the
program

Introduction to the program
VERCAM is a program for the design and verification of gravitational, semi-gravitational, and reinforced
concrete retaining structures, including the evaluation of the maximum safety factor obtainable under normal
and seismic conditions.
For structures in reinforced concrete VERCAM not only calculates the corresponding tensions in the material
but provides the dimensioning and the design of the necessary reinforcement as well. The verification of
stability, sliding and compression of the terrain is performed according to the regulations in use.
Based on the acknowledged formulas proposed by Coulomb and extended by Muller-Breslau, and by evaluating
the forces transmitted from ground to intervention, the tensions induced on the foundation and the tensions
present in the structure itself, the program analyses the different forces that determine the safety factor (ground
pressures, loads distributed on surfaces, and moments applied to the structure).
Therefore, given the minimum safety factor required by the enforced regulations, the program verifies that the
designed intervention structure reaches that value.
Fundamentally there are two problems faced by VERCAM: the calculation of wall stability and determining the
reinforcement to be used.
The stability calculation is performed through the determination of the safety factors against sliding and toppling.
The safety factor against sliding is determined as the ratio between the resultants of the stabilising and
destabilising horizontal components.
The stabilising components are formed by the product of the vertical forces resultant multiplied by the coefficient
of friction between the base of the wall and the ground, and increased by the strength offered by the diaphragm.
The destabilising components depend on the external horizontal forces and on the active pressure of the
ground, which are inclined because of the internal geometry of the wall and the wall-ground friction angle, and
exert both a (prevailing) vertical component and a horizontal component.
The safety factor against toppling is determined by the equilibrium of the moments and is calculated with
respect to the extremity of the external (downstream) bracket.
The tension on the ground is determined by the wall's total equilibrium. The distribution of the reaction is shown
on the drawing relative to pressures: in this way the program is able to determine the maximum tension exerted
on the ground as well.
The program performs the steel bar reinforcement calculation by determining the flexure stresses corresponding
to the constraint point between the two brackets and the elevated part of the wall.
Therefore the calculation of the steel bar reinforcement necessary is performed using the usual construction
methods.
If a distributed reinforcement is required with the presence of external (compressed) and internal (in traction)
steel bar reinforcement, the calculation is performed as it were a beam with double reinforcement; on the
contrary, when the distributed reinforcement is not required, a greater reinforcement will be added but it will be
positioned on the internal side of the wall only.
Calculation under seismic conditions is executed in pseudo-static conditions through the increase of the
horizontal and vertical forces using the seismicity coefficients entered by the user.
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Chapter 2 - System requirements
and program installation

System requirements
• Pentium® class processor

• Microsoft® Windows® 95 OSR 2.0, Windows 98, Windows Me, Windows NT®* 4.0 with Service Pack 5 or
6, Windows 2000, or Windows XP

• 64 MB of RAM (128 MB recommended)

• 100 MB of available hard-disk space

• CD-ROM drive

• A printer driver must be installed, even if the printer itself is not connected to the PC.

Program Installation
To install VERCAM run the vercam32setup.exe installation package from the CD-ROM or from the download
directory.

Press the Setup button…
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…and select the directory to create the VERCAM32 folder.
Click the Continue button and the program program is automatically installed.

The first time you run the program the window that allows you to select your preferred language appears.
Simply click on the flag of the language you prefer.

The language selection will be saved in the “LANGUAGE.CFG” file, which is found in the program directory. To
select another language, it is sufficient to exit the program and delete this file. The language selection window is
shown once more at the next run of the program.
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Chapter 3 - The program
protection

Hardware protection key
This section should instead be carefully read if the program was bought through the Internet.

Hardware protection key - Parallel port
Plug the hardware protection key that is supplied with the program into the parallel port connector of your PC.
The hardware key should be plugged directly into the PC, before any other device, to avoid hardware conflict
with other keys.
The printer cable can then be connected to the hardware protection key, as it does not interfere with the printing
operation. If the hardware key has not been correctly installed, the program will start in demo mode.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98 and Windows Me
Windows 95, Windows 98 and Windows Me automatically recognize the hardware key, so no other operation is
required.

Windows NT, Windows 2000 and Windows XP
Windows NT, Windows 2000 and Windows XP require the installation of a software driver to enable access to
the hardware key. To install the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. install the package

3. browse the program directory, and run the program SKEYADD.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

4. restart the computer

To uninstall the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYRM.EXE in the folder
HardKeyDrivers\Parallel_NT-2000-XP

3. restart the computer

Hardware protection key - USB port
Plug the hardware protection key, supplied with the program, into one of the USB connectors of your PC.

For further information about the hardware key, please visit the Web site http://www.eutron.com

Windows 95, Windows 98, Windows Me, Windows 2000 and Windows XP
All Windows versions, except Windows NT, automatically recognize the PnP hardware key, and require the path
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to load the driver from. To install the driver, follow this procedure:

1. start Windows, and login as Administrator (if necessary)

2. install the package

3. browse the program directory, and select the folder HardKeyDrivers\ USB_9x-Me-2000-XP

Windows NT
Windows NT requires the installation of a software driver to enable the access to the hardware key. To install
the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. install the package

3. browse the program directory, and run the program SKEYUSBADD.EXE in the folder
HardKeyDrivers\USB_NT4

4. restart the computer

To uninstall the software driver, follow this procedure:

1. start Windows, and login as Administrator

2. browse the program directory, and run the program SKEYUSBRM.EXE in the folder
HardKeyDrivers\USB_NT4

3. restart the computer
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Chapter 4 - Using the program in a
local network

Using the program in a local network
The programs can be used in a local network without moving the hardware key from one computer to another.
It is also possible to purchase multiple licenses to use the program on several computers at once.

The computer to which the hardware key is physically connected is defined as the “Server”, and the computer
that requests the authorisation to run in fully operational mode from to the Server is defined as the “Client”.
The program must be installed on the Server (with the proper hardware key drivers if necessary), and on each
Client (in demo mode).
The program keyserver.exe should also be installed on the Server. The installation file of this program can be
found on the distribution CD-ROM, or on the Internet, at the URL:
http://www.geoandsoft.com/download/KeyServerSetup.exe

Run keyserver.exe and the hardware key management window appears.

Click the “Create Program Configuration File” button, and browse your network to select the executable file you
want to remotely activate (for example \\computer03\c\program files\vercam32\vercam32.exe). Now, with the
keyserver.exe program running, vercam32.exe can also be run from the PC “computer03”.

NOTE: the contemporary use of the program on more then one computer is allowed only if a multiple
license has been purchased.
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Chapter 5 - General information

Usage Notations
Some typographical notations and keyboard formats are used in this manual to help locate and interpret
information more easily.

Bold print is used to indicate command names and related options. Characters appearing in bold print should
be typed exactly as printed, including spaces.

Words written in italics indicate a request for information.

CAPITAL letters are used to indicate computer, printer, directory, and file names.

Keyboard formats are used as follows:

• KEY1+KEY2 - indicates press and hold down key1 and then, at the same time, press key2. For example,
alt+c means one should press and hold the alt key down and, at the same time, press the c key. The keys
are always indicated with capital letters.

• key1,key2 - A comma (,) between key names means that the keys must be pressed in sequence. For
example, ALT,C means one should press and release the ALT key and then press and release the C key.

Because of the differences in keyboard layouts, the names of the keys on the keyboard may not correspond
with those described in this manual. The word ARROW (LEFT, UP, RIGHT, DOWN) indicates the use of the arrow
keys.
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Chapter 6 - User Interface

User Interface and Data Entering
The user interface is designed to be easy to use and powerful and is supported by complete on-line help. This
help contains practical hints and the theoretical background, where applicable. It should reduce the requirement
of  frequently consulting the printed manuals.
All the commands are located inside a menu bar. Each menu contains a list of commands that one can select
with the mouse or the keyboard. The arrangement of the menus, designed with ergonomic criteria, follows the
logical order of the operations, inhibiting the access to further operations until all the necessary data have been
entered.

The interface layout is maintained in all of our programs, to simplify, as much as possible, the transition from
one program to another to avoid having to learn different commands and procedures for similar functions (such
as entering data or managing files).
Let us examine the general components that are available in the user interface of geo&soft programs.

User Interface: Menu Bar and Menus
The Menu Bar manages the access to all the program commands. The goal of the menu design is to offer an
ergonomic, simple, and understandable arrangement of the commands.
The menus used to perform a complete operation are normally ordered left to right and top to bottom. When
possible, the following scheme is used: definition of the name of the project, entering the required data,
performing the calculation, and generating the output as a preview or final print.

The programs automatically disable some menus or commands when the execution of such menus or
commands is not yet feasible. Typical examples are: a calculation menu is disabled when not all the data
needed for the calculation have been completely entered, or a print menu is disabled if not all the calculations
have been executed.
To choose a command from a menu, use the following procedures:

Point the menu that is to be activated, click the left button of the mouse, then point the command to be
activated, and click the left button of the mouse again. If one does not wish to select any command
from the menu that is open, exit the area of the menu before releasing the mouse button.

Press the ALT key to activate the menu bar. Press, on the keyboard, the underlined character in the
menu name or press ENTER or the DOWN arrow, to select the first menu. Press on the keyboard the
underlined character in the menu name or select it using the arrow key and then press ENTER, to
execute a command in the selected menu. Press ESC to close the menus without executing any
command.

The Graphical Output Preview Window
The Toolbar is located in the upper side of the preview window.
The Toolbar allows fast access to the commands with the mouse. Click the corresponding icon, to select one of
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the commands that belong to the Toolbar. The Toolbar displays the following commands:

- Zoom + : clicking the first icon activates the ZOOM function (it can only be used with the mouse) that
permits the enlargement of part of the drawing. The function remains active until the Zoom - icon is selected.
To enlarge a part of the drawing:

click the icon, and then select the area to be enlarged by clicking the upper-left corner and dragging
the mouse pointer to the lower-right corner. At this point, release the mouse button. Note: due to the
low resolution of the screen, the texts could appear in a slightly different scale at different zoom levels.
This does not affect the quality of the final printouts.

- Zoom - : click this icon to return to the original scale of the preview.

- Arrows: click the arrow icons, in "Zoom + " mode, to pan the on-screen preview.

- Print: click the print icon to send the drawing to the default printer.

- Resized print: click this icon to send the drawing to the default printer. The image will be resized to fit the
current paper size.

- DXF: one can export the graphic output as a DXF file by clicking this icon; it gives access to a dialogue
window that enables one to assign a different name to the DXF file, which has, by default, the same name
as the current project.

- EMF/W: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Microsoft Word. Clicking this icon gives access to a dialogue window that enables
one to assign a different name to the EMF file, which has, by default, the same name as the current project.

- EMF/D: This icon allows the graphic output to be exported to a version of the Enhanced Windows Metafile
which is compatible with Corel Draw. Clicking this icon gives access to a dialogue window that enables one
to assign a different name to the EMF file, which has, by default, the same name as the current project.

- Exit: click this icon to close the preview window and return to the main menu.

The Input Dialogue Windows
The different menu commands can perform an immediate action, or display a dialogue window in order to input
or edit the various data sets.
When a dialogue window is visible, all the actions that do not pertain to it are ignored. Hence, it is necessary to
close the dialogue window to resume the normal use of the program.

Some fundamental tools are used inside the dialogue windows: data fields such as text and list boxes, and
buttons.
The text boxes are used to input numerical values and text strings. Most of the editing keys (HOME, END, INS,
DEL, etc.) can be used inside these fields. If one sees a small arrow pointing down on the right side of the data
field, one has a list box.
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To scroll the list box and select an item, do as follows:

click the arrow, and then click the item to be selected.

press the DOWN arrow until one arrives at the item to be selected. It is also possible to press a letter to
directly reach the first item that begins with that letter.

Tere are three buttons in the dialogue window:

• <Ok> - this button saves the entered information and goes on to the next phase.

• <Cancel> - this button closes the Dialogue window without saving the just entered data, or without
executing the command.

• <Help> - this opens a window that contains general information on how to use the dialogue windows.

To use the buttons:

click the button

press alt+underlined letter
To edit the data inside the dialogue window, use the following keys:

• TAB - moves the cursor to the next field; when the cursor is inside the last visible field the cursor goes to the
first control button of the Dialogue window. To return to the previous field, press SHIFT+TAB.

• ENTER - moves the cursor to the next field. If the cursor is positioned on one of the window buttons, the
corresponding command is executed.

• BACKSPACE - cancels the last character that has been entered.

• DEL - cancels the character to the right of the cursor.

• ESC - closes the Dialogue window without saving the entered values or without executing the command. The
<Cancel> button will do the same.

• UP ARROW/ DOWN ARROW - these are used in multiple fields, or those fields that have a list box.

• LEFT ARROW/ RIGHT ARROW - moves the cursor to the previous or next field.

• HOME -moves the cursor to the beginning of the field.

• END - moves the cursor to the end of the field.

A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Data Input With Tables
Tables are used to enter long sequences of numerical values and/or text strings. The keys to be used are the
following:

• TAB - moves the cursor to the first button in the window. When one presses this key again, the cursor is
moved to the next button.

• SHIFT+TAB - moves the cursor to the previous button.

• ENTER - moves the cursor into the next input field. If the cursor is positioned on one of the window buttons,
the corresponding command is executed.

• PAGE UP - moves the cursor up 15 lines.

• PAGE DOWN - moves the cursor forward 15 lines.

• UP ARROW - moves the cursor to the input field directly above.

• DOWN ARROW - moves the cursor to the input field directly below.

• LEFT ARROW / RIGHT ARROW - moves the cursor to the field respectively to the left or to the right of the current
position.

• HOME - moves the cursor to the beginning of the line.

• END - moves the cursor to the end of the line.

• F2 - copies the field contents to the extended editing field under the title bar in order to facilitate the editing
of the long strings. When working in this editing field, please REMEMBER to press ENTER, even before
clicking the <Ok> button. Double-clicking a field has the same effect as pressing the F2 key.
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The tables have two additional buttons:

• <Insert> - creates an empty line before the one in which the cursor is positioned.

• <Delete> - deletes the line in which the cursor is positioned.

IMPORTANT SUGGESTION: you can copy data to or from other programs such as Microsoft Excel:

The data entered in the table can be copied in order to be pasted into another table.
To copy the table’s contents:

press the key combination CTRL+C. The contents will be copied into the Clipboard of Windows.
To paste the Clipboard contents into the table:

press the key combination SHIFT+INS, or CTRL+V.
A yellow box with a short text that explains the meaning of the value to be entered, can be seen in the lower part
of the window. If the text is not completely visible, click the yellow box to read the complete text.

Message Windows
The function of these windows is to give information to the user concerning the system status, as in the case of
an error due to an improper use of the program.

Help On Line
A complete Help On Line is available. It is possible to ask for information or suggestions related to the
commands or the use of the program. In order to access the help on line, proceed as follows:

1. Position the cursor on a field of a dialogue window and press F1.

2. Use the Summary from the Help menu.
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Chapter 7 - Commands

Files Menu (ALT,F)
This menu contains the commands for opening and saving files, that contain all the information relative to the
project. Until a name for the project has been given the program will not permit the use of other menus.

New Command (ALT,F,N)
To open a new file:

from the menu choose New by first clicking on the name of the menu then on the New command.

from the File menu choose New by using the combination of the keys ALT,F,N.

Open Command (ALT,F,O)
To be able to work with the program one should, first of all, create a new file or open a pre-existing file. To open
a file:

from the menu choose Open by first clicking on the name of the menu then on the Open command. In
the File Name field type the name of the file to be opened or, if the file already exists, double click on
the name of the desired document which can be found in the list underneath the File Name field.

from the File menu choose Open by using the combination of the keys ALT,F,O. In the File Name cell,
type the name of the file to be opened or, if the file already exists, press TAB and then the UP ARROW or
DOWN ARROW to select the name from the list underneath the File Name field and press ENTER.

The name of the file being used is shown inside the title bar of the main window and inside a window referable
by selecting the Help menu.
The name of the file should not contain spaces and/or punctuation marks. It is not necessary to indicate
extensions, since the extension “.MCT” is added automatically: for example, if one enters the name “TEST1” the
file name will be “TEST1.MCT".

Save Command (ALT,F,S)
During the work session the program uses a copy of the file which is temporarily loaded into the computer’s
RAM. To save the work on the hard disk it is necessary to use the Save command; otherwise all the data
entered will be lost when one exits from the program. If an electrical problem or any other type of problem
interrupts the computer’s functioning, the data not yet saved will be lost, so it is advisable to save the work
often. To save a file:

select Save from the file menu by clicking first on the name of the menu and then on the Save
command. In the File Name field, the name given to the file when it was originally opened appears. To
confirm that name click on the <Ok> button. To assign a new name to the file, type the new name in
this field.
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select Save from the File menu by using the key combination ALT,F,S. To confirm the name given to
the file when it was opened press ENTER. To assign a new name, type the name in the File Name field
and press ENTER.

The program will save the file in the current disk unit and directory unless specified otherwise. To save the file
on a different disk unit or in a different directory, type the full path in the File Name field. For example, to save
the document in the root of disk C: type c:\filename or select a different unit or directory.

Printer Setup Command (ALT,F,P)
By selecting this command one goes to “Print” dialog box. Here one can verify and modify the Default printer’s
Setup or select another printer from those installed one ones system.
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Edit Menu (ALT,E)
This menu is for the input data necessary to the program for the calculation or the verification of the retaining
wall.

Geometry Command (ALT,E,E)
Through this window it is possible to define the geometric and the characteristics of the retaining structure.

The "Geometrical parameters" Dialogue Box
To do so one needs to enter:

→ Internal wall dip: the given dip is expressed in degrees, and indicates the inclination of the wall from the
vertical (positive downwards).

→ External wall dip: the given dip is expressed in degrees, and indicates the inclination of the wall from the
vertical (positive upwards).

→ Total height of the wall: the total height of the structure, derived from the sum of the foundation height and
the wall height.

→ Foundation height (centre): height of the wall in correspondence to the attachment of the wall.

→ Foundation height (ext. external): height of the external extremity (downhill) of the foundation.
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→ Foundation height (ext. internal): height of the internal extremity (uphill) of the foundation.

→ External bracket length: dimension of the external sole of the wall.

→ Internal bracket length: dimension of the internal sole of the wall.

→ Wall width at the base: width of the wall in correspondence to the foundation attachment.

→ Unit weight of the wall: the average weight of the unity of volume of the material forming the retaining
structure, including possibly the weight of the steel bars.

In the case of a gravity wall, the height of the foundation and the dimensions of the internal and external
brackets is obviously zero and the width of the wall at the base coincides with the total dimension of the
foundation.

Ground Command (ALT,E,G)
Through this window the geotechnical parameters are entered. Note that the problem is treated in terms of
effective tensions and under drained conditions.

The “Soil Parameters” Dialogue Box
The “Soil Parameters” dialogue box displays the following fields:

→ ground dip: this is the dip expressed in degrees with respect to the horizontal of the ground immediately
above the retaining structure. The positive direction is upward.

→ ground-wall friction angle: this is the friction angle between the earth and the internal wall. The material
upstream from the reinforcement must be improved until the geotechnical characteristics have bettered.

→ internal ground friction angle.

→ friction coefficient at the wall base.

→ unit weight of the ground, immediately above the wall.

Loads Command (ALT,E,L)
Through this window it is possible to define the characteristics of the external stresses imposed on the structure
that is to be constructed, for example in the case of bridge shoulders or walls bolted at the top.

The "External Loads" Dialogue Box
The data required are:
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→ External moments: indicates (for linear meter of wall, positive=toppling) the entity of the external moment
applied to the summit of the wall, due, for example, to the presence of a bracket protruding from the top of
the wall.

→ Normal force: indicates (for linear meter of wall) the size of the vertical force applied at the summit of the
wall, due to the vertical load transmitted by the floor system on the shoulder of a viaduct, for example.

→ Distance external wall - normal force: defines the position of the force defined in the previous line.

→ Shear force: the entity of the eventual horizontal force (positive=destabilizing) applied to the top of the wall,
like the rupture force on the shoulder of a viaduct for example.

→ Diaphragm strength: indicates the entity of the shear strength that an eventual anchorage tooth (diaphragm)
is able to develop.

→ Overload: the overload, due for example to the external weight or passing of vehicles, present on the terrain
uphill from and in proximity of the wall; note that the weight of the inclined ground is computed separately
and does not depend on this value.

→ Seismic coefficient: these coefficients must be expressed with absolute values (ex.: to express a coefficient
of 7%, 0.07 is to be entered).

Reinforcements Command (ALT,E,R)
This information is to be supplied only when a steel reinforced cement wall is designed for a structure that is not
gravitational. In fact, only in this case the dimensioning of the reinforcement and calculation of the existing
tensions in the cement and steel of the most stressed section is required and possible.

The "Reinforced concrete calculation" Dialogue Box
The data required are:
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→ Steel reinforcement distribution: indicates the eventual presence of a steel reinforced fissure restraint to be
positioned externally. To position the steel reinforcement at the maximum distance indicated in the following
lines, the minimum diameter is considered.

→ Diameter of the bars, there is the possibility to enter up to four different diameters that will be used in the
calculation of the steel reinforcements.

→ Steel and concrete admissible tension

→ Steel reinforcement minimum and maximum step: indicates the minimum and the maximum distance that
the program can use for the sizing of the steel reinforcement structure. The program determines the step
according to the previously indicated diameters.

→ Steel bar covering: the steel bar covering is the thickness of the layer of concrete that covers the steel
reinforcement.

Titles Command (ALT,E,T)
To facilitate the reading of the drawings produced by the program a main title and 3 sub-titles are provided.
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Print Menu (ALT,P)
With this menu it is possible to produce graphic output or listings of all data by selecting from the following menu
titles: Graphics and Listings.

By selecting one of the commands present in this menu the program calculates the data using the method
proposed by Muller-Breslau. When the calculation is complete, the graph pertaining to the command selected is
produced.

Graphics Command (ALT,P,G)
With this command one has access to a sub-menu, used to select the result to be visualised and printed.

Pressures Command (ALT,P,P)
By selecting this command the program begins the calculations, then makes a drawing of the wall with the
diagrams of the pressures exerted by the terrain and the pressures on the foundation.

Forces Command (ALT,P,F)
By selecting this command the program begins the calculations, then makes a drawing of the wall showing the
forces generated by the terrain, the weights of the wall components, the external loads and the eventual seismic
forces.

Reinforcements Command (ALT,P,R)
By selecting this command the program begins the calculations, then makes a drawing of the wall with the
arrangement and description of the steel bars. This command can be carried out only if the data relative to the
steel bars have been entered in the editing phase.

Listings Command (ALT,P,L)
By selecting this command the program opens a sub-menu where one can select the preview mode, and wether
to print or export the listing.

Listings Preview Command (ALT,P,L,P)
With this command it is possible to preview the listings pertaining to the calculation result. The listing can not be
changed here.
To scroll the text use the scroll bars on the window or use the UP and DOWN arrow keys, or the PAGE UP e PAGE
DOWN. keys. To exit press ESC or double-click any point of the listing.
The file containing the listing is saved on disc in the same directory where the data files resides. It has the same
name with the difference of the ".TAB" extension. The file is in the normal ASCII format and its pagination is
such that all commands have the # sign as prefix.

Fast Print Listings Command (ALT,P,L,F)
With this command the listings pertaining to the calculation result are printed directly.

Export Listings in DOC Format (ALT,P,L,E)
With this command the listings pertaining to the calculation result are exported in the format used by Microsoft
Word 97.
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The file will have the same name but with the ".DOC" extension and will be saved in the same directory where
the data files reside.
At the end of the file exportation this file will be visualised by invoking the Winword program.

Export Listings in TXT format (ALT,P,L,T)
With this command the listings pertaining to the calculation result are exported in the “Text only” format.
The file will have the same name but with the ".TXT" extension and will be saved in the same directory where
the data files reside.
At the end of the file exportation this file will be visualised by invoking the Notepad program.

Export Listings in SLK format (ALT,P,L,S)
With this command the listings pertaining to the calculation result are exported in the “SLK” format.
The file will have the same name but with the ".SLK" extension and will be saved in the same directory where
the data files reside.
At the end of the file exportation this file will be visualised by invoking the Excel program.

Configure Command (ALT,P,C)
With this command, one can define the graphical properties of the different objects in the graphical output.

One can associate a colour, a line thickness and a character font to each object. Notice that not all the objects
have both a line thickness and a character font: for example, a title only requires the colour and the character
font to be defined.

• Click an object to select it (use the scroll bar to see the entire list)

• Click one of the option buttons, in the “colours” frame, to select the colour that has to be associated to the
selected object. The Not drawn option hides the object of the graphical output.

• If the object contains texts, one can choose a character font from the list (use the scroll bar to see the entire
list)

• If the object contains lines, one can assign a thickness to the lines (in mm). If the value is zero, the program
uses the thinnest line on the output device.

• It is possible, as an option,  to assign a left and a top margin (in cm) to the whole graphical output.

NOTE: although the available set is limited to fifteen colours, they can be manually customised; double-click the
coloured bar to open the Colour Dialogue Box and choose a different RGB value associated to the selected
colour.
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Exit Menu (ALT,X)
This command allows one to exit the program. If the file being used contains modifications that have not yet
been saved the program will propose the file saving window, if you would like to save these modifications.
To save a file:

click on the <OK> button. It is possible to assign a new name to the file by typing the new name in the
File Name field before clicking the <OK> button.

Press enter. To assign a new name to the file type the new name in the File Name field and then press
enter.

To abandon the modifications:

click on the <Cancel> button: the file will abandoned and the modifications will be lost.

press esc to select the <Cancel> button, this closes the file without saving.
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Chapter 8 - A first example

A first example
In this chapter we present a simple and easily worked example. We suggest one to follow this example to
familiarise oneself with the program.
Remember that the only parts to be typed are those appearing in bold print while single keys are identified by
SMALL CAPITAL characters.

1. Start the application by double clicking on the VERCAM icon. To close the message box click on the <OK>
button or press ENTER or the SPACE BAR.

2. Now one is inside the program. Click on File to open the menu, and then click on the Open command.

3. Type the file name test in the File Name field and click on the <OK> button to confirm.

4. Now start to enter the data. Click on the Edit menu and select the Geometry command by clicking on it.

5. Now pass on to entering of the wall geometry and enter the following values:

5 TAB

10 TAB

4 TAB

0.5 TAB

0.3 TAB

0.3 TAB

1 TAB

1.5 TAB

1.2 TAB

20  TAB

To finish entering data click on <Confirm> button.

6. Open once more the Edit menu and select the Ground command to enter the geotechnical parameters and
geometry of the terrain. Enter the following values, remembering to press the TAB key to pass on to the next
field:

15 TAB

20 TAB

30 TAB

0.5 TAB

18  TAB

To finish entering data click on <Confirm> button.

7. Open once more the Edit menu and select the Loads command. Here one enters the data relative to the
external loads (other than the terrain pressure), the resistance of the foundation edge and eventually the
seismic coefficient relative to the zone in which the structure is being designed. The procedure for data
entering is the same as that used previously:

10  TAB

50 TAB

0.4 TAB

0 TAB

0 TAB

20  TAB

0 TAB
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To finish entering data click on <Confirm> button.

8. Now continue to enter the data relative to the concrete reinforcement with the Reinforcement command. The
program automatically chooses the best configurations of diameters and spacing between the bars. Press
the TAB key to pass to the second field without modifying the first, then enter the data:

12 TAB

14 TAB

16 TAB

18 TAB

160 TAB

10 TAB

200 TAB

400 TAB

30 TAB

To finish entering data click on <Confirm> button.

9. Before performing the calculation of the data, entered open the Edit menu and select the Titles command.
Enter the titles desired, remembering to press the TAB key to move the cursor from one field to the next. As
one can see the, titles which are longer than the field, are scrolled and have a part hidden; it is possible to
modify or correct these by scrolling the cursor with the ARROW keys. To confirm click on the <OK> button.

10. In this way one has finished entering data and can pass on to the calculation. Open the Print menu by
clicking on it. One can choose from the following options:

- Graphics: in this sub-menu activated by selecting this command to visualise and print the diagram of the
stresses due to the weight of the terrain and to the accidental load, the scheme of the forces resulting from
pressures, external loads and dimension of the wall, the scheme of the steel bars, determined using the
available diameters and limits given to the steps between bars.

- Listings: under thus command one finds the sub-menus that allow one to visualise, print and export the
result listings.

- Configure: permits the definition of the colour configurations, the size and set of characters to be used in
the printing of graphics.

11. Select the Graphics command. After the execution of the calculations, the duration of which is dependent on
the type of computer used, the drawing that shows the calculated results is drawn. With the instrument bar
one can carry out the following operations:

- Zoom +: enlarges a part of a page. Note: if one does not have a character font suited for the visualisation
of the selected dimension, the program will substitute it with another.

- Zoom -: returns the drawing to the original dimension.

- Arrows: clicking on the arrow icons after having activated "Zoom +" one can pan the drawing visible on
screen.

- Print: clicking on this third icon, or pressing the letter p key, will send the drawing to the default printer.
When the printing has finished the program returns to menu.

- Resized print: by clicking on the command the drawing is printed on the default printer resized in such a
way as to be drawn on a single page.

- DXF: clicking on this command gives access to a dialogue box that enables one to assign a different name
to the DXF file, which has by default, the same name as the data file.

- Exit: closes the window and returns to the program.

12. To terminate the work session select the Exit menu. If the file being used contains modifications that have
not yet been saved the program will propose the “Save as” dialogue box. To save the file click on the <Ok>
button.
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